# Table of Contents

- **Introduction to i-Extend**: 3
- **Inbox**: 11
- **Patient Lists**: 27
- **Orders**: 49
- **Result Viewing**: 57
- **The MAR, MAR Summary and Med Profile**: 71
- **Notes-Documents/Patient Info**: 87
- **INet**: 105
CHAPTER 1

Introduction to i-Extend

Chapter 1 Highlights

- How to sign on
- Overview of PowerChart
- How to find a patient
- PowerChart icons
- Descriptions of Chart tabs
**Introduction to i-Extend**

i-Extend is used to access the Clinical Information System at Florida Hospital. I-Extend consists of several programs. Practicing physicians will use one of these applications:

- **PowerChart** is used by most Physicians and Mid-Level Providers. It is covered by this manual.
- **FirstNet** is for ED Physicians and Mid-Level Providers and is covered elsewhere.

### Logging into i-Extend

NOTE: These logon instructions may change as newer versions of FHMD (FHDOC) are implemented. The general principles, however, will not change.

Click on the iExtend icon to use i-Extend.

A CernerWorks Explorer window will open. This window serves as a gateway to create and maintain a secure connection to the i-Extend application and database.

There may be more than one icon in the Application window. Select the PowerChart icon to log onto i-Extend. ED clinicians will use the FirstNet icon.

Physicians will not have access to other program icons that may appear in this window and should not select them.
A login screen will appear.

Physicians should enter their Florida Hospital six digit Username/Operator ID (OPID) and Password.

Press the <Enter> key or click the “OK” button.

When physicians first log into i-Extend, they will see the Organizer. This page contains the Inbox, Patient List Tab, and Apache.

The Inbox is where physicians will sign and review medical records.

The Patient List tab provides access to physician rounding lists.

Apache is a critical care prognostic tool.

These applications will be covered later in this manual.

Overview of the Patient Chart

Opening a Patient Chart

There are several ways to enter and interact with a patient’s electronic chart.

The most common method will be to double click on a patient’s name on any patient list.
The Find Patient Icon allows users to find a patient within the hospital’s Clinical Information System regardless of current or previous admission (encounter) status.

Click on this icon to search for a patient not already included on a patient list.

The Patient Search window will open and allow users to search for a patient by FIN, MRN, Name, Date of Birth, or SSN.

Search matches are shown in the top window.

The bottom window shows encounters associated with that patient. The most recent encounter is always on top and is selected by default.

Polly has been admitted twice, most recently at Florida Hospital Orlando.

Note: FIN stands for Financial Number. It replaces our previous Account Number. MRN stands for Medical Record Number. It replaces our previous MRI number.
Another way to open a patient chart is from the Inbox. Users can right click on a patient’s name and select Open Patient Chart from the drop down menu. A sub-menu will allow users to select which particular tab of the chart to open.

It is not possible for any user to open a chart without declaring a relationship to the patient. This is how the system complies with HIPAA regulations.

Declaring a Provider-Patient Relationship is only necessary the first time a chart is opened and is not necessary for Admitting, Attending, or Referring physicians. These 3 relationships will be automatically assigned during the patient registration process.

Organization of the patient Chart
A patient’s electronic chart contains a Menu Bar, Task Bar, Banner Bar, Chart Tabs and Clinical Information windows.
The Menu Bar
The Menu Bar contains drop down menus used to perform various tasks within the i-Extend application. It works like the menu bar in Excel, Word, and other Windows applications.

The Toolbar
The Toolbar contains shortcuts to the most common i-Extend menu tasks.

The As Of button
Icons to the LEFT of the As Of button apply to the entire application and do not change.

Icons to the RIGHT of the As Of button apply to the particular page on the screen. In this case, the icons to the right are used to perform tasks within the Orders tab, which is currently open.

The As Of button is a refresh button. Clicking on this button refreshes the current screen.

The Banner Bar
The yellow Banner Bar identifies the patient and provides information about FIN, MRN, Location, Code, Visitor, Allergy, and Isolation Status.

The phrase “FHMD History” under the patient name indicates the patient was registered in the Florida Hospital system before May 1, 2007 and indicates there may be old records available for review within Floridahospitalmd.org.
### Commonly Used Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Find Patient" /></td>
<td><strong>Find Patient</strong>&lt;br&gt;Opens the Patient Search Window to find and open a patient’s chart (see above)</td>
</tr>
<tr>
<td><img src="image" alt="Organizer View/Patient Chart" /></td>
<td><strong>Organizer View/Patient Chart</strong>&lt;br&gt;Toggles between the Organizer View (containing the Inbox &amp; Patient Lists) and the patient chart view</td>
</tr>
<tr>
<td><img src="image" alt="Previous/Next Patient" /></td>
<td><strong>Previous/Next Patient</strong>&lt;br&gt;Opens the Previous or Next patient chart on the active patient list</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td><strong>Exit</strong>&lt;br&gt;Closes the chart and exits the application. This is the preferred method of logging off i-Extend</td>
</tr>
<tr>
<td><img src="image" alt="Launch Application" /></td>
<td><strong>Launch Application</strong>&lt;br&gt;Opens a drop down menu containing shortcuts to various useful Internet or Intranet sites. This will include FHMD, Medical Library, PACS, UpToDate, and others.</td>
</tr>
<tr>
<td><img src="image" alt="Clinical Calculator" /></td>
<td><strong>Clinical Calculator</strong>&lt;br&gt;A tool containing formulas and conversion factors for useful clinical values such as Creatinine Clearance, Cardiac Index, and much more</td>
</tr>
<tr>
<td><img src="image" alt="Ad Hoc Charting" /></td>
<td><strong>Ad Hoc Charting</strong> is used by nurses. Physicians will not use this icon.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td><strong>Print</strong>&lt;br&gt;Prints a paper copy of the current screen on the nearest network printer.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td><strong>Help</strong>&lt;br&gt;An online help tool providing additional information about the current screen</td>
</tr>
</tbody>
</table>
Chart Tabs

The patient’s electronic chart is organized using tabs. Each tab contains an electronic version of the information physicians would expect to see in that portion of a paper chart. Subsequent sections of this manual will discuss the contents and use of these chart tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orders</td>
<td>Active Orders &amp; Order Sets</td>
</tr>
<tr>
<td>Results</td>
<td>Flowsheets containing test results and assessments</td>
</tr>
<tr>
<td>VS</td>
<td>A flowsheet of Vital Sign results</td>
</tr>
<tr>
<td>Clin Sum</td>
<td>A 3 day snapshot of clinical information on the patient</td>
</tr>
<tr>
<td>I/O</td>
<td>A flowsheet of Intake and Output measurements</td>
</tr>
<tr>
<td>Rad</td>
<td>A flowsheet of Radiology reports and imaging results</td>
</tr>
<tr>
<td>Lab</td>
<td>A flowsheet of Laboratory results</td>
</tr>
<tr>
<td>Micro</td>
<td>The last 30 days of Microbiology results with sensitivities</td>
</tr>
<tr>
<td>INet</td>
<td>An interactive nursing flowsheet with advanced graphing capabilities</td>
</tr>
<tr>
<td></td>
<td>(Interactive Network)</td>
</tr>
<tr>
<td>Notes/Documents</td>
<td>Electronic transcribed and scanned documents from current and past encounters (an encounter can be either an admission or outpatient visit)</td>
</tr>
<tr>
<td>MAR</td>
<td>The electronic Medication Administration Record</td>
</tr>
<tr>
<td>MAR Summary</td>
<td>An abbreviated version of the MAR tailored for physicians</td>
</tr>
<tr>
<td>Med Profile</td>
<td>A summary of inpatient and outpatient medications</td>
</tr>
<tr>
<td>Drug Ref</td>
<td>Access to the Multum drug database and Education Leaflets</td>
</tr>
<tr>
<td>Pt Info</td>
<td>Patient Allergies, Demographic Information, Visit History, Summary of Provider-Patient Relationships, FH Vaccinations, Growth Charts and coding summary</td>
</tr>
<tr>
<td>Forms</td>
<td>Data entry forms completed by nursing to assess patients and document care</td>
</tr>
</tbody>
</table>
CHAPTER 2

Introduction to Inbox

Chapter 2 Highlights

- Inbox design
- Overview of Sign and Review
- Overview of Documents to Dictate
- How to Refuse a document
- Residents only – how to forward to Attending
- How to batch sign documents
- New documents available to sign
The Inbox

When physicians first log into i-Extend, they will see the Organizer Page. This page contains the Inbox, Patient List, and Apache tabs. The Inbox is opened by default.

The Inbox is a physician communication tool. It contains a list of documents requiring review, signature, or dictation. It also contains a messaging system allowing physicians to exchange information and notes about patients.

The Patient List tab will be discussed in another section of this manual.

Apache is a critical care prognostic tool.

The Inbox contains three major sections. Each is represented by an icon on the Listbar.

**Sign and Review** is opened by default when physicians first sign into i-Extend. Physicians will sign documents in this section.

**Inbox Messages** allows physicians to exchange email-like messages within the i-Extend system *only*.

**The Trash Can** contains deleted documents.
The Sign and Review folder contains

1) **Documents to Sign**: Transcribed or scanned documents awaiting signature.
2) **Documents to Dictate**: Notifications about documents requiring dictation.

The number of documents requiring review or signature is noted on the listbar and next to the appropriate folder.

Unopened documents that require review or signature are listed in a bold font. Documents that have already been reviewed are in normal font.

Double-click the patient's name to review a document before signing it.

The document will open in a new window.

The **Banner Bar** across the top of a dictated report displays identifying information about the patient.

The **Document window** allows physicians to review the entire document before signing it.

The **Inbox Action Pane** allows the user to:
- Sign the document
- Forward the document to a supervising physician (Residents only)
- Refuse documents sent to the Inbox
Signing a document

Within the Action Pane, the document *Sign* action is selected by default. Users can:

- Click the OK button to sign the document and leave the document open for further review
- OR
- Click the OK & Next button to sign the current document and automatically open the next document for review.

Once the document has been signed, an “Electronically Signed By: ….” Signature line will be added to the bottom of the document.

Once a document has been signed or reviewed, it will disappear from the Inbox. A Permanent copy is stored under the Notes/Documents Tab in the patient’s chart.

Refusing a document

To refuse a document, open it by double-clicking on the patient’s name to review the document.
The Sign Action is selected by default.

Change the Sign Action to the Refuse option in the action box.

Select the Signature button in the forward area.

Be sure that “HIM Inbox” is displayed in the To: window.

This sends the document back to HIM (Medical Records) and indicates to them you have refused to sign it. They will then arrange for the correct physician to sign it.

Note: Do not forward documents (refused or otherwise) to anyone other than HIM Inbox. Documents forwarded to anyone other than HIM Inbox may not be acted upon and, if unsigned, may become delinquent and result in revocation of your admitting privileges. NEVER forward documents to anyone other than HIM.

All document refusals must have a reason. There are four options. Select the most appropriate reason.

Select the OK button to refuse the document.

Changing a Document

Documents can always be corrected or modified using the dictation system. Log onto the dictation system and be sure to enter the correct FIN number and document type. Tell the transcriptionist which document needs to be modified and how to modify it (“The third paragraph in the H&P is incorrect. Rather than state “the patient complained of pain,” it should state “the patient did NOT complain of pain”…). The transcriptionist will modify the document as requested.

When modifying a document, physicians should select the refuse to sign option and forward it to the HIM Inbox with the reason “Modification Dictated” as highlighted above. Once the document has been modified, it will re-appear as a document to sign.

An alternate method of modifying documents is to handwrite any changes directly onto a printed copy of the report. This altered paper document must be given to HIM. They will make changes to the document and an updated version will appear in the Inbox for signature. Once again, the incorrect version of the document should be refused using the “modification dictated” reason.
Co-Signature of Documents
(Residents only)

Residents are required to both sign and forward their documents to a supervising physician for co-signature.

Residents should open and review the document by double clicking on the patient’s name or document subject.

The document review window will open. In the Action Pane, the “Sign” action will already be selected by default.

The document must be both signed and forwarded to the supervising physician. DO NOT USE THE FORWARD ONLY OPTION.

In the Forward area, select the For: Signature option.

Enter the supervising physician’s name in the To: window or search for the supervising physician’s name using the Address Book.

Click on the “… ” box to the right of the To: entry field to open the address book.
In this example we have changed the supervising physician’s name to Dr. Gray.

If desired, physicians can add a comment when forwarding documents. This comment will show in the notifications comment column in the receiving Physician’s Inbox.

Once all information has been entered, click the OK button (or OK & Next). This will sign the document for the resident, and simultaneously forward it to the supervising physician for a co-signature.

This is a screen shot of a supervising physician’s Inbox.

The forwarded document is designated by a red arrow in front of the patient’s name, indicating that this document has been forwarded from another physician.

Comments entered by the resident are visible in the Notification column.
When the supervising physician opens the document, the dictating resident’s name appears beside the Performed By: at the top of the document.

Note: It is not possible to forward multiple documents at once. Individual documents must be forwarded one at a time. It is easiest for residents to do this using the “OK & Next button.”

Notifications of documents requiring dictation will be found under the Documents to Dictate header.

Double-click on a document to open it.
A document window will open, but it will contain only identifying information and the statement “This is an anticipated document.” This indicates that HIM is requesting the physician to dictate this document.

No action (other than dictation) is required. The documents to dictate are notifications only. Documents will automatically disappear from this section as soon as a dictation is completed (and the “As Of” button is pressed). Once the document has been transcribed, it will appear in the Documents to Sign section.

Physicians can select the Refuse action and forward the notification back to HIM along with an appropriate reason, such as “Not my patient” or “Dictation not needed.”

**Batch Signatures**

It is possible to sign more than one document at a time. (Residents cannot use this feature because they must both sign and forward documents)

First, physicians must select which documents to sign in one batch. There are several methods to do this.

**Method 1**

*While holding down the shift key, select the first document (click on the patient’s name or subject once)*
Continue to hold the shift key and select the last document to be included in the batch.

All documents between the top and bottom one will be highlighted and selected for batch signature.

Hold the <Shift> key and click on the last document

Method 2

Hold down the CTRL key and then, one by one, single click on any combination of documents.

Remember to hold down the CTRL key during the entire selection process.

All selected documents will be highlighted and selected for batch signature.
Method 3
Select the first document to be signed.

Then *hold down the Shift key* and press the down arrow key. Each time the down arrow key is pressed another document underneath will be selected.

Remember to hold down the Shift key throughout this process.

Once all documents have been selected, click the ‘Sign all documents’ icon on the toolbar. All of the selected documents will be immediately signed.

The signed documents will remain visible in the Documents to Sign area until the “As of” button is clicked to refresh the screen.

Note: It is not possible to forward multiple documents at once. Because residents are required to both sign and forward documents to their supervising physician; they cannot take advantage of the batch signature feature.
Inbox Messages

The Inbox Message tool is an internal email system. Messages exchanged in this system are internal to the i-Extend system only. To ensure patient confidentiality, it is not possible to send or receive internet email from within i-Extend.

To open a message, double click anywhere on the message line.

Messages can be sent to any physician in the i-Extend system. Only physicians have access to Inbox messages. Nurses cannot send or receive messages.

To send a message about a patient, select the patient’s name from the Sign and Review folder, from a previous Inbox message (click once anywhere on the document or message line), or just open a new (blank) message composition window.

Click the Inbox message icon in the toolbar to open a message composition window.

Users can also open the message composition window by Right clicking anywhere in the message window and select “Inbox Message” from the dropdown menu.
The Patient Name field will already be completed if this message was opened about a patient. *All messages containing a patient name become a permanent part of the patient’s chart.*

Select a physician(s) to receive this message.

Enter the physician’s last name in the “To:” window. A provider selection window will appear if there is more than one match for the name. Choose the correct match and click OK.

A message can be sent to up to 5 physicians at a time. Separate each additional recipient by a semi-colon (;). Only physicians can exchange Inbox messages. Nurses do not have access to Inbox messages.

Compose the message and click one of the Send buttons. They are located at the top left (circled) or right (not shown).
When composing a message about a patient, the system matches the patient’s name with the hospital’s registration system.

The “Save to patient’s chart” box will be checked by default. In this example, the checkmark was manually removed.

*Even though the checkmark was removed, users should assume that this message might still be saved to Polly Patient’s chart.*

*Always assume that all messages will become a permanent part of the medical record.*

To delete a message, highlight the message.

Click the delete button on the toolbar to move the message to the trash can.

Users can also Reply, Reply to All, and Forward messages to other physicians.
Paper Based Documents

Regulations require that certain documents must be completed in HIM. These documents will be identified in the Documents to Dictate area of the Inbox, along with a brief note in the Subject Column such as “Final Progress Note – Please go to HIM.”

Paper based documents cannot be electronically signed. They can only be refused and forwarded back to HIM.

The most common document requiring completion in HIM will be a Final Progress Note.

Medicaid Certifications

Physicians will no longer have to go to HIM and sign a paper Medicaid Certification. They will be signed electronically by opening the document for review and then signing it.

Inbox Time Frame

The Inbox includes documents that are up to 45 days old. Physicians who are away from the hospital for more than 45 days will need to change this time frame to see all of their documents.

To view older documents, click the rectangle across from the ‘Since date’
A drop-down box will appear. Select a different range to display in the Inbox.

Note: If there are a large number of old documents, it may take longer to open. For this reason, it is unwise to leave documents unsigned for long periods of time.
CHAPTER 3

Introduction to Patient Lists

Chapter 3 Highlights

- Types of Patient Lists
- How to Add and Remove a patient
- How to build a patient list
- How to Add columns
- How to Print a list – inhouse and remote
Patient Lists

Patient Lists serve as an organizational tool for physician rounds and patient information. Physicians will use these lists to decide where and how to make rounds. Lists can be viewed electronically or printed out. Physicians will most commonly enter their patient’s electronic chart from a list.

Physicians will have several patient lists pre-built for them when i-Extend is first activated. They can have up to 15 different lists and can create, delete, or modify the content and appearance of them. This section will cover the use, creation, and maintenance of patient lists.

Accessing Patient Lists

When users first log onto i-Extend, an Announcement window will appear. The messages in this window are controlled by MIS.

To suppress this announcement, check the box at the bottom before closing the window. It will not reappear unless the text of the message is altered.

After closing the announcement window, click on the Patient List Tab.

The Patient List tab will open to reveal currently active lists. Each tab represents a different list. Any single patient’s name may appear on more than one of these lists (and often will), depending on how the lists have been configured.
Types of Patient Lists

There are four types of patient lists. Understanding these basic list types will help physicians understand how patients are added or removed from a list.

- **Location lists** (the Unit Census) – A list of patients on a nursing unit or similar location. The unit census list will always be the first patient list on the Patient List tab and will open by default. This list is updated automatically. Users cannot add or remove patients from Location Lists.
- **Visit Relationship lists** – A list of patients “related” to a clinician. This list is updated automatically when a patient is admitted, discharged or a consult is requested. Physicians may add to or remove patients from these lists.
- **Provider Group list** - A list of all patients in your group.
- **Custom list** – A list of patients created and maintained by a clinician. This list is NOT updated automatically. Users must manually add to or remove patients from this list.

Physicians will be able to build new lists or modify pre-built lists to suit their needs. The Physician Informatics Team has pre-built the following lists for physicians: A **Group List** (if the physician is in a call group or PA), **My List**, **Discharges in last 3 days**, **Admits last 48 hours**, & **Pending Results**. These lists are described later. The Physician Informatics Team can help users modify or build these and other lists.

Using Patient Lists

Physicians can open patient charts from any patient list. All patient lists can be can be sorted and printed.

**Opening a Chart from a List**

To open a patient chart from a list, double click anywhere on the patient’s name or line.

The patient’s chart will open in a new window.
Sorting Patient Lists

Users can re-sort patient lists by clicking on any column heading.

To sort this Tower 10 location list by patient name, click on the “Name” column header. The list will be resorted alphabetically by last name.

Printing Patient Lists from INSIDE the hospital

Physicians may want to print a copy of their patient list. Printing lists when inside the hospital is very simple:

First, select the list to be printed and sort it (if desired) using the appropriate column headers. Physicians will most likely want their list sorted by Location. First click on the facility column to sort by facility and then click on the location column to secondarily sort it by room location.

Once the list is sorted, click on the print icon and the list will print on the nearest printer.

Printing Patient Lists from OUTSIDE the hospital

A different printing technique is necessary when outside the hospital because a home or office computer is not connected to hospital network printers.

Using a web browser, navigate to the FHMD website:
http://www.floridahospitalmd.org

Go to the Home page, and select Outside Hosp Production Domain from the available links. A login window will appear.
If you have not downloaded Citrix on your computer, please do so by selecting the Citrix Icon to install and run i-Extend.

Login using your FH Username and password.

Select the Powerchart icon from the application selection window. The Firstnet icon is for ED physicians. Do not select any other application icons that may appear.
i-Extend will open. Close the Announcement screen, then click on the Explorer Menu icon to the left of the *As Of* button.

The Explorer application will open. Several reports will be visible under the Main Menu. If the Main Menu folder is closed, double click to open it.

Select Patient List or Patient List (with lines) to print out a list without (or with) extra lines.

Do not change the Output selection in the top window. The “MINE” tells your computer to send the report to the computer’s default (local) printer.

Choose a patient list to print from the *Select Patient List* window.

Click the *Execute* button in the bottom right hand corner of the screen. The Patient List report will run and appear in a new window.

Click the print icon at the top of the screen. The Patient List will print on the computer’s default printer.
Commonly Used Patient Lists

i-Extend will come with several pre-built lists. These will include the Unit Census, A Group List (if the physician is a member of a group), and My List. The Unit Census cannot be changed, but all other lists can be modified, if desired. This section describes these common lists and how to create, modify, rename, hide or delete lists.

**Unit Census (a Location List)**
Most hospital computers will be associated with a nursing unit. The Unit Census list is a list of patients registered to the computer’s nursing unit. This list will only appear on computers assigned to a particular nursing unit. Users cannot add or remove patients from this list.

This tab cannot be removed from your list. When present, it will always be the first list.

**Group List (Provider Group List)**
This list includes all patients associated with anyone in a provider group at the selected facilities. It is updated automatically. Users can add or remove patients by creating or terminating a relationship with the patient.

(Facility=Campus. Celebration Health is considered a “facility”).

**Provider List or “My List” (Relationship List)**
This is a physician’s personal list. It is updated automatically. Users can add or remove patients by creating or terminating their relationship with the patient.
Adding and Removing Patients from Lists

Patients will automatically be added or removed from physician lists as they are admitted or discharged from the hospital. This is done by PFS (admission) personnel. When registering a patient, admissions personnel assign an admitting or attending relationship to the appropriate physician. It is this relationship assignment that causes patients to be appear or disappear from lists.

There may be situations when physicians will want to manually add or remove names from a patient list. For example, a patient’s name will not appear on a consultant’s list before the consult order was entered into the computer system. Conversely, a name will remain on a consultant’s list until the patient is discharged, unless the consultant “signs off” of the case.

Manually Adding Patients to a list

To add a patient to a list, physicians should select the appropriate list (in this case, the “My List” tab), then click on the “Add Patient” icon, as shown.

A Patient Search window will appear.

Search for the desired patient by FIN, Name, DOB, MRN, or SSN.

Select the desired patient from the matches in the top window.

Select the appropriate visit (encounter) in the bottom window. The most recent encounter will always be at the top of this window.
If this is your first contact with the patient during this admission, the system will prompt you to declare a relationship with the patient. A Relationship assignment is necessary for HIPAA compliance and determines whether names will appear on a patient list. Think of it as ‘signing on’ the case.

It is not necessary for physicians to declare Admitting, Attending, or Referring relationships. These assignments are handled by Admitting personnel.

Once a relationship is selected, the patient’s name will appear on visit relationship lists, including your Group list (if any) and My List.

Manually removing patients from a list
Think of this as ‘signing off’ the case. To remove a patient from a list, select the patient (right or left click on the patient name) and click on the “Remove Patient” icon on the toolbar.

Users can also right click on a patient name and select “Inactivate Relationship” from the drop down list.

Physicians cannot terminate an Attending relationship. This must be done by PFS (Admitting) personnel.
Building and Modifying Patient Lists

i-Extend provides a “wizard” to help users build new lists. This section will go through the steps to create a list so users can understand the creation and modification process. We will create “My New List” as an individual visit relationship list designed to show “your” patients at 5 hospital campuses.

From anywhere on the Patient List tab, click on the “List Maintenance” icon (shaped like a wrench), to open the “Modify Patient Lists” window.

The Modify Patient Lists window will appear. It allows you to activate or inactivate existing lists, make new lists, or delete old ones.

Click on the “New” button to create a new list.

Choose which type of list to create. There are only 3 choices (see above for a discussion of these types).

“My New List” will be a Visit Relationship List.

Select the Visit Relationship option and click on the “Next” button.
On the next screen select the visit relationship types to include on this list. Relationship types control which patient names will appear on a physician’s list. At the very least, physicians should select:

- Admitting Physician
- Attending Physician
- Consulting Physician
- Referring Physician

Physicians performing chart reviews should also select Chart Review Physician.

A (very) few other types may be advisable, depending on the physician’s situation.

NOTE: It is not advisable to check off the “Select all relationships” box. If all relationships are selected, the list will be cluttered with the names of patients visiting the hospital for outpatient tests or procedures not relevant to inpatient rounds, the major function of patient lists.

Before you click the “Next” button, the list must be named.

The wizard automatically assigns a name containing all of the selected relationship types. Delete the text placed inside the Name window by the system and replace it with a more descriptive name, such as “My New List.”

Click the “Next” button.
The next step allows users to filter out unwanted encounters from the list.

Each hospital encounter has a Status (inpatient or outpatient) and Visit Type (ED, Lab, Radiology, etc.) Select the Status and Visit Types to include on the list.

Since this is an inpatient list, we want to include all patients with a status of “Not discharged.”

Appropriate Visit Types may vary greatly from one physician’s practice to another. Most physicians should select the following Visit Types:


Physicians should be aware that changes to these filter types may result in patient’s names inappropriately appearing or not appearing on a list.

Click on the “Next” button.
The next step allows users to filter out facilities (hospital campuses). Only selected campuses will be included on the list.

If you do not select any facility, patients at ALL facilities will be included on this list.

If one or more of the facilities is selected, only patients from the selected facilities will be included on the list.

For this list we have selected Apopka, Celebration, East, and Orlando patients to be included. You may choose to select different facilities, depending on your practice needs.

Click the “Finish” button.

| Click on a campus name to select or deselect it |
| Select the list, then click on the arrow to move it to the Active List window |

The new list (in this case named “My New List”) will appear in the “Available” window.

“My New List” must be moved to the Active list window before it will show up as one of the patient list tabs. Select it and use the arrows to move it over to the “Active” window.
Once “My New List” is moved to the Active List window, Click the “OK” button.

“My New List” is now activated and will appear on the Patient List tab.

Here is the newly created list

**Inactivating a List**
To inactivate a list, highlight the list name in the Active Window, click the arrow to move it to the Available Window. The list will disappear from your patient list tab but remain available for use at a later date.

**Deleting a List**
To permanently delete a list, move it from the Active Window to the Available Window.

Once the list is inactive, RIGHT click on its name and select “Delete Patient List”
Rename a List

Click on the list name twice (slowly – at least one second between the first and second click). The name will be highlighted and can be changed as desired.

Press <Enter> when you are satisfied with the new name and click “OK” to close the Modify Patient Lists Window.

Changing List Filters

Users can change list filters.

To change the filters for “My New List.” Click on the List Properties icon, which is next to the List Maintenance icon.

The Customize Patient List Properties window will open.

Open the Filter Facility tab to change facilities for the list.

In this example we will deselect Florida East from the list

Click the “OK” button to close the window.
Here is a screen shot of “My New List” after this change.

Note that Carla Vastrain, an inpatient at Florida East, has disappeared from the list.

Deselecting Florida East on the Filter Facilities tab prevents Florida East patients from appearing on this list.

Lists For Special Situations

Patient lists can be created or customized to streamline rounds or handle special situations. We will review four lists which can be used to solve common rounding problems.

Note: The Physician Informatics Team may have already created these special lists. If they do not appear on the Patient List tab, they may be hidden. Click on the Modify Patient Lists icon (the monkey wrench) and look for them in the Available window. If these lists do not exist, the Physician Informatics Team can assist.

Pending Results (A Custom List)

Physicians may want to review results that are still pending at the time of discharge, such as Pathology reports or TB cultures. A Pending Results list is useful for physicians who want to be reminded to check on these results after the patient goes home. The computer system will \textit{never} add or remove patients from a custom list, so names added to this list will remain even after the patient is discharged. Physicians can add a patient’s name to this list as a reminder. Once the results become available and are reviewed, the patient’s name can be manually removed from the list.
Physicians can copy a patient’s name from any list onto a Pending Results list.

To copy Polly Patient from My List to the Pending Results list:

Right click on the name, hover over the “Add to a Patient List…” and click on the “Pending Results” list.

Polly Patient’s name will remain on the Pending Results list until manually removed.

After reviewing Ms. Patient’s results a few weeks later, remove her from the list by selecting her name (click once on the name) and then click on the “Remove Patient” icon.

**Building a Pending Results List**

If not already available, users can create a Pending Results list (a Custom List) as follows:

Open the Modify Patient List wizard (the wrench). Select “New” button.

Select a “Custom” patient list type.
Enter a name for the list such as “Pending Results”

Select a status of “None” and Type of “None”

Skip the Proxy setup page and click the “Finish” button.

**Admits last 48 hours (A Relationship or Provider Group List)**

Patients are often admitted or discharged while a physician is gone for the weekend or on vacation. The Admits last 48 hours list is designed to help returning physicians locate these admissions. It is updated automatically by the system based on admission dates and relationships.

When i-Extend if first activated, the Admits last 48 hours list will be configured to show a list of patients from your group or personal list admitted within the last two days. Admitted patients will be removed from this list after the selected time interval has passed.

To change this list to cover admissions over a longer time interval:

Select the list.

Click on the List Properties icon and change the “Admitted within the last..” time frame to any other desired interval.
Building an Admits last 48 hours List
If not already available, users can create this list as follows:

Open the Modify Patient List wizard (the wrench) and select “New” button.

Select a “Provider Group” (for a list of recent admits to the entire group) or “Visit Relationship” (for a list of recent admits to your name only) patient list type.

If this will be a group list, users must select a group from the options provided.

If this is a Visit List, users must select the type of relationships to include on the list. Selections should be identical to the user’s normal “My List”

Give the list a name, such as “Recent Group Admits”
Select a Filter status of “Admitted within the last”

Select the encounter types to include on this list. Selections should be identical to those of the user or group’s normal list so that the only difference between the two lists will be whether they were admitted within the last “X” days.

Select a time interval at the bottom of this screen. The default will be 2 days.

Skip the Proxy setup page and click the “Finish” button.
D/C last 3 days (A Relationship or Provider Group List)

Patients may be discharged while a physician is gone for the weekend or on vacation. The D/C last 3 days list is designed to help returning physicians locate these patients. It is updated automatically by the system based on discharge dates and relationships.

When i-Extend is first activated, the D/C last 3 days list will be configured to show a list of patients from your group or personal list discharged within the last 3 days. Discharged patients will disappear from this list after the selected time interval has passed.

To change this list to cover discharges over a longer time interval:

Select the list.

Click on the List Properties icon and change the “Discharged within the last..” time frame to any other desired interval.

Users can also change the filters for this list as described above.

Building a D/C last 3 days List

If not already available, users can create this list using the same procedures described above for the Admits last 48 hours list.

The only difference is that users must select a Discharge status, rather than an Admitted status.
Customizing The Appearance Of Patient Lists

Patient Lists come with standard columns, but additional columns are available. Users can add, subtract, or re-order the columns and save these modifications as their default.

Open the “Customize Columns Tool” by clicking on the toolbar icon (highlighted in the box) or selecting “Customize Columns…” from the Patient List drop down menu.

Use the arrows to move columns between the Available and Existing windows. The up and down arrows allow users to change the order that columns appear on a patient list.

Click on the disk icon to save the settings or they will revert back to the defaults the next time you log on.
CHAPTER 4

Introduction to Orders

Chapter 4 Highlights

❖ Overview of Orders
The Orders Tab

Physicians will not enter orders electronically during the first phase of i-Extend implementation. Orders will continue to be written on paper order sheets. These orders will be entered into i-Extend by the Health Unit Coordinators (HUCs) and nurses (for patient care orders) and Pharmacists (for medication orders).

To maintain consistency with our legacy paper charting system, and to prepare physicians for Computerized Physician Order Entry (CPOE) in Phase II. The Orders Tab is the first tab inside a patient’s chart. It will be opened by default when a physician first enters a patient chart. Physicians will be able to view i-Extend orders entered by HUCs, nurses and pharmacists here.

The Orders tab contains a View Window and an Order Window.

The View Window is similar to the Navigator used on Results tabs. It controls which types of orders are displayed in the Order Window.

The View Window is divided into three sections.

**Orders for Signature**
When this section is selected, the Orders window will display any orders that are awaiting signature.

**Plans**
Linked Order Sets (PowerPlans)
When this section is selected, the Orders window will display orders contained within the selected Power Plan. (Power Plans are groups of linked orders).

**Orders Profile**
When this section is selected, the Orders window will display all current orders. This will include orders that may be part of a Power Plan. In this screen shot, the Orders Profile section has been selected and current orders for this patient are displayed on the right.

---

<table>
<thead>
<tr>
<th>Orders for Signature</th>
<th>Orders awaiting signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plans</td>
<td>Linked Order Sets (PowerPlans)</td>
</tr>
<tr>
<td>Orders Profile</td>
<td>(selected here) shows Currently Active Orders in the Order Window</td>
</tr>
</tbody>
</table>
The Orders Tab shows all orders that were active or discontinued within the last 5 days. This can be changed by using the drop down window at the top of the screen.

The Orders Tab can be customized by modifying filters controlling which orders are displayed.

Click on the Options menu and select Filters…

The Filters window will open.

Users can modify settings to control the way orders are sorted (within clinical categories), how orders are to be displayed, and which order statuses to include in the display.

The default settings are shown on this screen shot. Users should, in general, not modify these defaults.
In a paper chart system physicians must often search through pages of order sheets to find a particular order.

In i-Extend, the Orders Profile Section is subdivided into Clinical Categories. Orders are automatically placed into one of these categories. This makes it much easier to find and review a particular order. An IV order, for example, will be easy to find in the Continuous Infusion Clinical Category. This is one way EMRs can speed physician workflow.

Note: The grey checkbox next to each category controls whether the clinical category will be displayed (or not) in the order window. The checkboxes are selected by default when the Order Tab is opened. To be sure all orders are visible; leave all categories checked.

This is a screen shot of the Orders Profile, containing all orders that were active or discontinued within the last 5 days.

Note how orders are categorized and displayed within the relevant Clinical Categories.
The Order Window uses 5 columns to display a summary of each order’s details.

The first column contains a checkbox which denotes whether the order has been completed (checked) or not (unchecked).

The second column contains various icons that open additional information (such as an insulin sliding scale), tools (such as a clinical calculator), or indicate needed action (such as nurse review required).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="checkmark.png" alt="Checkmark" /></td>
<td>Checkmark indicates order has been completed. No checkmark indicates order is not complete.</td>
</tr>
<tr>
<td><img src="icons.png" alt="Icons" /></td>
<td>Icons indicate additional info, tool, or action</td>
</tr>
</tbody>
</table>

**Order Details Not Complete:** Indicates that there are required order details that have not been completed for the orderable.

**Care Set:** Indicates a care set orderable.

**Clinical Calculator:** Launches the clinical calculator so that you can make a calculation.

**Comment Indicator:** The icon of a pushpin on a yellow note means that an order comment was entered for the order described on the same line. To view the comment, right-click the order and select Comments.

In PowerOrders, order comments (if any) are also displayed on the profile. Up to four lines of text are displayed. If there are more than four lines of text, an ellipsis (...) is displayed. Drag the column line to enlarge the space to show the additional information, or select the order and follow the steps above to open the Order Information For (orderable) window.

**Clear All:** Clears the Order Details window.

**Dose Calculator:** Launches the dose calculator.

**Free Text Allergy:** Indicates that an allergy was entered as free text rather than selected from the database. This means that no system checks for drug or food interactions will be done on the allergy described on the same line.

**Nurse Review:** This icon indicates that nurse review is required.

**Pending Complete:** This icon means that the order has reached its stop date and time. One-time orders display an order status of Ordered in the Status column. They can be completed or canceled but not modified. Continuing orders display a status of Pending Complete and can still be modified.

Here is a listing of each icon’s meaning.
The third column shows the order name.

The fourth column shows the order status. Order statuses may include: **Ordered, In Process, Future, Incomplete, Suspended, On Hold, Pending, Canceled, Completed, Pending, Complete, Deleted, Voided with results**

The fifth, and final, column shows selected order details.
To see all of an order’s details, **right click** on the order and select “Order Info…” from the menu.

An Order Information window will open with additional details about the order. This includes who initiated the order or modified it.
It is possible to look at the results from an order directly from the Order Tab.

Right Click on the order and select “Results…” from the drop down menu.

The same Order Information window will open to the results tab, revealing the result.

This view of the result functions as it would on the Results tab. Users can double click on the Results tab to see additional details about the result (when it was collected, etc).

Note: This manual does not cover the order entry process. When i-Extend is first activated orders will be entered by Health Unit Coordinators (HUCs) and nurses (for patient care orders) and Pharmacists (for medication orders). In preparation for CPOE (Phase II) additional training material will describe the physician order entry process.
CHAPTER 5  

Introduction to Results Viewing

Chapter 5 Highlights

- Overview of Results layout
- How to graph results
**Viewing Results in i-Extend**

Physician’s traditional concept of a “result” is a lab value or test report. Within i-Extend, however, a “result” is defined as any type of data entered into the patient’s chart. Results include nursing assessments, Vital Signs, Allergies, and even an H&P or Clinical Summary document.

There are multiple ways to view results within i-Extend. Most results will be viewed on one of the dedicated Result tabs. Results are displayed in a tabular (flowsheet) format on the Results, VS, Rad, and Lab tabs. Custom Florida Hospital views were created for the Clinical Summary and Microbiology tabs.

---

### Clinical Range Bar

![Clinical Range Bar](image)

The Result tab is organized using a Clinical Range Bar, Navigator window and Data window.

The Navigator window is used to move data within the data window without using scroll bars. Results are grouped by Clinical Categories (Vital Signs, Lab, Diagnostic Radiology, etc) and each bar on the Navigator corresponds to a clinical category group of results. Click on one of these bars to bring that group of results to the top of the data window.

---

### i-Extend contains only one tab called Results

i-Extend contains only one tab called Results, but the VS, Rad and Lab tabs are specialized versions of the Results tab filtered to show only Vital Signs, Radiology and Lab results. The Result tab concepts learned in this section are applicable to all of these tabs.

---

### The Clin Sum tab is a custom view of results for yesterday, today, and orders for tomorrow.

The Clin Sum tab is a custom view of results for yesterday, today, and orders for tomorrow.

---

### The Micro tab displays all Microbiology culture results along with sensitivity information for the previous 30 days.

The Micro tab displays all Microbiology culture results along with sensitivity information for the previous 30 days.
The Clinical Range

The blue Clinical Range Bar at the top of every flowsheet (and many other chart tabs) displays the time frame covered by the flowsheet.

The default time frame for the Results tab is 48 hours in the past and 24 hours in the future. This time frame is suitable for most result viewing.

The arrows to the left of the clinical range bar will expand or contract the past date limit in 2 day increments. The arrows to the right of the clinical range bar (not shown on this screen shot) will expand or contract the future date limit in 2 day increments.

Right click anywhere on the clinical range bar and select Change Search Criteria to open the range selection window. Several range options are available here.

Note: Result displays are not limited to the current admission. By expanding the Clinical Range into the past, it is possible to view results for multiple encounters (admissions) on the same results flowsheet.
The Results tab defaults to the “At A Glance” view covering selected results from the last 48 hours.

The Results tab also contains “Specialty” flowsheets available from the Flowsheet drop down menu.

The All Results Flowsheet is an unfiltered list of every result available within i-Extend.

The Vitals and Lab Views are identical to what users will see under the Lab and VS tabs.

The Critical Care, Infectious Disease and other specialty flowsheet views have been customized to emphasize data pertinent to those clinical situations.

Specialty Views relevant to physicians tend to be located near the top of the list. Specialty Views relevant to nursing are denoted by “Nsg” at the end of the specialty flowsheet name.

There are three different display views to result flowsheets. The radio buttons at the top right of each flowsheet allow users to change the view.

The Table view is selected by default. Results are shown in a reverse chronological horizontal format with dates across the top. In this view it may be necessary to scroll right and/or down to see all results in the clinical range.
The **Group view** displays results in a reverse chronological vertical format with dates along the left (most recent data on top). This view is, essentially, the same as the table view with the X and Y axes reversed. One advantage of this view is there is more data on a page. Results will not go beyond the right margin but it may be necessary to scroll down to see all results in the clinical range.

The **List View** displays results in a reverse chronological vertical format (most recent results on top and oldest at bottom).

Clicking on the Event Date or Event column header title allows the results to be sorted. This is the only view that allows sorting. Results will never go beyond the right margin but it may be necessary to scroll down to see all results in the clinical range.

**Chronology**

Time flow can be changed from Reverse Chronological (the default) to Chronological by using the Time Scale menu option. These changes are not saved after logout.

The Time Interval (time between columns or rows) is always “Actual” and cannot be changed.
Changing Viewing Properties

Flowsheet view preferences may be customized by selecting Options, “Properties…” from the drop down menu.

The Flowsheet Properties window will appear.

Property setting changes can be saved as defaults for all future logins by clicking the “Save” button when changes are completed.

In this screen shot, the display font has been increased to make result pages easier to read.

Abnormal Results

Results that are outside “normal” ranges are identified by textual indicators and color coding.

The result legend can be viewed by selecting Options, “Result legend…” from menu.
The Result Legend window is shown here.

The Result legend applies to Results, VS, Rad, and Lab tabs.

**Finding Abnormal Results**

If the Clinical Range is large or there are many results in a short time span, it can sometimes be difficult to scroll through the results to find abnormal values. i-Extend has a Seeker to help locate abnormal results.

Select the Seeker... from the Options menu. The Seeker window will appear.

The Seeker provides a bird’s eye view of all result locations within the clinical range. The bold rectangle inside the Seeker represents the area of results visible on the computer screen. Each dot represents a result. The color of the dots mimic result color codes.

By dragging the rectangle around the Seeker (hold down the right mouse button and move the mouse pointer), users can select an abnormal result cluster. Release the mouse button to view this area of results.
Graphing Results

Numerical results can be graphed. These result types will have a small grey check box to the left of the result name.

Select the results to be graphed by clicking one or more checkboxes. More than one result can be graphed at a time.

Then click the graph icon to show the graph(s).

A Flowsheet Graph of the selected results will appear. Each result’s graph will appear in its own window.

The graphs can be combined into a single graph by selecting the “Combine” button at the bottom right.

Certain data types are not suitable for viewing on a combined graph because their scales may differ significantly. For example, on a graph of Potassium and Sodium results it would be difficult to see trends in Potassium levels because of the larger scale required for the Sodium results.

The combined graph(s) can be split into their individual graph windows by selecting the “Split” button.
Result Details

Details about any result can be viewed by double clicking on the result value.

A Result Detail window will open.

The Action List tab on this window will show who performed the test, when, and additional details.
The Vital Signs (VS) Tab

The Vital Sign (VS) tab is identical to the Vitals Specialty Flowsheet selected from the Results drop down menu. This view is filtered to show only Vital Sign and Pain assessment results.

The default clinical range for the VS tab is 7 days in the past and 1 day in the future.

The VS Tab can be viewed and customized like any other reports flowsheet.

The Clinical Summary (Clin Sum) Tab

The Clinical Summary tab (Clin Sum) is a custom view of results for yesterday & today and orders for tomorrow.

The Clinical Summary should be viewed online for the most recent results.
The Intake and Output (I/O) Tab

The Intake and Output (I/O) tab is a specialized view of Intake and Output results.

The default Clinical Range for the I/O tab is 2 days in the past and 1 day in the future.

The yellow column indicates the current timeframe. Green areas are shift and daily results. Blue areas indicate date and time information collected by the system.

The default time interval is 8 hours. Click the “Select Time Scale…” button (circled on this screen shot) to select hourly, 2 hours, 4 hours, 8 hours, or daily time intervals.
The Radiology (Rad) Tab

The Radiology (Rad) tab is a specialized view of only Imaging Results. This tab includes results for Interventional Radiology, Diagnostic Radiology, Bone Density, CAT scans, Mammography, MRI scans, Nuclear Images, PET Scans, and Ultrasounds. It does not include Cardiology Imaging (which can be found under the Notes/Documents Tab).

The default Clinical Range for the Rad Tab is 5 years in the past.

The Rad Tab Flowsheet will display the status of Imaging tests. Completion of a test is indicated by the appearance of the test name on the flowsheet, such as “XR Chest 1 View” in this screen shot.

Once a test is complete, a transcribed result report can be viewed by double clicking on the test name. A document window will open containing the transcribed report. Users can read the entire radiology report from this window.

If an image is attached, the last line of the document will state “This document has an image” and the View Image icon at the top of the document window will light up. To view the image, click on the View Image icon.
An Internet Explorer window will open. The image associated with the report will automatically appear in a PACS image viewer.

Only the image associated with that particular Radiology report can be viewed here.

To compare old and current images, physicians will need to log into the full PACS system.

To log into the full PACS system, click on the Application Launcher available at the top of every i-Extend screen. Select PACS from the drop down menu.

The Laboratory (Lab) Tab

The Laboratory (Lab) tab is identical to the Lab View Specialty Flowsheet selected from the Results drop down box. This view is filtered to show only Laboratory results.

The default clinical range for the Lab tab is 7 days in the past and 1 day in the future.

The Lab tab displays Laboratory and Microbiology results. The Lab tab can be viewed and customized like any other reports flowsheet.
The Microbiology (Micro) Tab

The Microbiology (Micro) tab is a custom view created to only show detailed Microbiology culture results and sensitivities on a single screen. These results are also visible on the Lab tab. Results are only available on this tab for 30 days. To see older results, physicians must go to the Lab or Results tabs.

Micro results are shown in a textual format.

Results on the Micro tab cannot be manipulated, filtered or sorted. Users cannot customize the default format.
CHAPTER 6

Intro to the MAR, MAR Summary and Med Profile

Chapter 6 Highlights

❖ Overview of MAR

❖ How to read the layout

❖ MAR and MAR Summary icons

❖ How to read the Med Profile

❖ How to print an Education leaflet
The MAR, MAR Summary and Med Profile Tabs

i-Extend contains three electronic versions of the MAR. The MAR tab was created with nursing documentation in mind and is intended for their use. The MAR Summary is a simplified version of the MAR with a layout and format more suited for physician needs. The Med Profile allows physicians to compare inpatient and outpatient medication lists.

### The MAR tab

The MAR tab display covers a time span from 1 day back to 1 day forward.

The Clinical Range may be changed by right clicking on the blue Clinical Range bar and select “Change Search Criteria…”

The MAR tab is organized with a Navigator pane and a Medication pane.

Within the Navigator pane, there is a Time View and a Therapeutic Class View. In the Time View, as shown here, medications are grouped into the major administration category types:

- Scheduled, Unscheduled, PRN and Continuous Infusions (see below for definitions) along with Future and Discontinued medication groupings.

Click on the Therapeutic Class View at the bottom of the Navigator window to view medications displayed by Therapeutic class.
In this example, all anti-neoplastics, cardiovascular agents, and other medications are grouped together regardless of their administration schedule.

Click on the Time View to go back to this default view.

The MAR Navigator functions as it does on flowsheets. Click on the Unscheduled bar to bring the unscheduled medications to the top of the medications window.

**Scheduled** medications include any medication given on a regular schedule. **Unscheduled** medications include onetime orders, such as meds given on call. It does not include PRN medications. **PRN** medications are those scheduled to be given as needed. **Continuous Infusion** medications are any continuously infusing IVs or drugs, such as D5W, Dopamine drips, etc. The **Future** medication bar is not currently being used. It is reserved for future use. **Discontinued** medications display located at the bottom of the window.
### Medication Pane

The first column of the Medication Pane contains the name of the drug, selected details of the order, and may also contain icons that indicate the status of the order.

The medication is always identified in a bold font using its generic name first. If a different name (usually the brand name) was used when the medication was ordered, it will appear in parenthesis at the end of the first line.

Subsequent lines contain details of the order.

Users can expand the medication column by dragging the vertical line to the right, as shown here, to see more details.

Alternatively, right clicking on the medication name and selecting “Order Info…” allows users to see all order details.

Users can hover over the medication order to see selected dosing comments from the pharmacy.

One or more icons may be displayed above a medication’s name. The meaning for each of these icons is detailed below.
**Icons on the MAR and MAR Summary Tabs**

**Hard Stop Renewal:** Hard-stop orders discontinue after they reach their stop date/time. If a physician orders a medication for three days, it stops automatically in three days.

**Soft Stop Renewal:** Orders that reach their soft stop need to be renewed or discontinued. The difference between a hard stop and a soft stop is that soft-stop orders are not discontinued automatically.

**Give With:** The medication is to be given along with another medication at the same time. Click on the icon for a popup window which will show all of the “give with” medications together.

**Nurse Review** Indicates that nurse review of the order is required.

**Admin Note** Indicates that there is a nurse-to-nurse communication attached to the order, such as "Do not allow patient to walk unassisted".

**Pharmacy Comment** Indicates that there is a pharmacy comment attached to the order.

**Pending:** The order is past its stop time but has not yet been discontinued.

**Request Pharmacy Verification** The medication order has not been verified by the pharmacy.

**Rejected by Pharmacy** The order has been rejected by the pharmacy. Check all order information before administering.

**Note:** If a new order is rejected by pharmacy, the order is not dispensed. However, an order that previously has been verified and dispensed can be rejected upon an erroneous modification. The rejected icon alerts the nurse not to give the medication.
Medication administration (dose) status is indicated by a color code for each dose.

The yellow colored column indicates the current time period.

- **Red**: A dose is overdue by 1 hour or more
- **Grey**: Discontinued medication
- **Blue**: A dose is due within 1 hour
- **Green**: A PRN medication
- **Peach**: An Unscheduled medication

Black Font over white or pale background indicates the nurse has documented that the dose has been administered.

Nursing comments may appear within a dose box, such as “Not previously given” or “Last Given” for Continuous Infusions and PRN Medications.
**Left Click MAR Charting Function:** The MAR was designed so nurses could directly document medication administration.

Left click over a dose, such as the prn ZoFran dose shown here, to bring up a charting window. The nurse would enter the required details, such as the site of administration, and then click on the check mark at the top left of the screen to mark the med as “given.”

**Physicians should never chart a medication administration even though they have this ability.**

**Right Click MAR functions:**

Right click over a medication dose to open a window with a list of possible actions.

To see details about that particular dose (route, site, etc) select “Order Info…”

It is possible to “Quick Chart…” the administration of a dose with a single click (and without an “are you sure?” window appearing).

**DO NOT select Quick Chart!**
The MAR Options menu allows users to modify several MAR settings.

Change Search Criteria… controls sorting and changing the MAR Date Range. The MAR defaults to a date range of 1 day back and 1 day forward. The MAR is sorted alphabetically within each medications category. These default ranges and sorting can be temporarily modified, but will revert to the defaults at the next login.

The Auto Refresh default is OFF for physicians. Click on the “As of” button to refresh the view.

The MAR Properties window controls font size, column widths, medication and IV administration display information.

Once all changes have been completed, click “Save” to store selections for future logins.

The MAR Filters window controls which type of medication orders will display. All order types are selected by default.
The MAR Summary Tab

The MAR Summary was created for physicians as a simple and concise view of the MAR. It is not possible to document medication administration from this window.

The MAR Summary is organized similar to the MAR, but there is no Navigator Pane. Medications are grouped into the same categories of Scheduled, Unscheduled, PRN and Continuous Infusions.

Discontinued meds are gray and intermingled with active ones.

The MAR summary date range covers 2 days back (at 4 hour intervals) and 8 hours into the future.

Users can change the default time interval settings. Right click on the blue Clinical Range bar and selecting “Change Defaults...” or select “Options” on the menu bar and then “Change Defaults...” from the drop-down menu.
The Mar Summary Defaults window will appear.

The Compass to the left of the Clinical Range bar serves as a substitute for the Navigator panel. It may be used to move the Scheduled, Unscheduled, PRNs and Continuous Infusions medications to the top of the Med Summary window. It can also be used to temporarily change Properties or time intervals for this window. Any changes made here will revert to the defaults when logging off.

Users can also change the Properties of the display by right clicking on the Clinical Range bar or selecting Options from the menu bar and then “Properties…” from the drop down menu.
The Mar Summary Properties window will appear. Users can change date ranges and column intervals for the current session—but these settings are not saved as defaults for the next login.

Users can also reset some filters and options for the MAR Summary.

Color Coding for the MAR Summary is similar to the MAR.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>A dose overdue by 1 hour or more</td>
</tr>
<tr>
<td>Grey</td>
<td>Discontinued medication</td>
</tr>
<tr>
<td>Blue</td>
<td>A dose is scheduled at this time</td>
</tr>
<tr>
<td>Green</td>
<td>A PRN medication</td>
</tr>
<tr>
<td>White</td>
<td>A nurse has documented administration of the dose</td>
</tr>
<tr>
<td>Orange border</td>
<td>A dose was scheduled but was not given</td>
</tr>
</tbody>
</table>

A delta sign next to a dose time indicates that someone corrected the charting on that dose administration.
Hover over a medication dose to display a popup window with selected details about that dose administration.

For full information, click on the “Details” button in the lower right corner of this popup. A detail window similar to the one seen on the MAR tab will appear (not shown here).
The Med Profile Tab

The Med Profile Tab allows users to view inpatient and outpatient medications on one screen.

### Medication Profile View

This is the default view when the Med Profile tab is opened. Medications are grouped into 3 broad categories:

**Pending:**
Meds on “hold” or ordered, but not yet started.

**Medication(s) being Given:**
Current and Past (discontinued) Inpatient Medications for the current admission only.

**Prescription(s)/Home Medication(s):**
Current and past home medications as reported by the patient. Notice that all of these medications are preceded by “Hx” (for Historical) or “Rx” (for Prescriptions)

**Current** home medications include only those medications taken by the patient during this admission. This information is obtained by nursing during the patient’s intake interview.

**Past** home medications include any historical home or prescription medications taken at any time prior to the current encounter. If the patient has been admitted several times, users may see multiple entries for the same medication.

### Table Example

<table>
<thead>
<tr>
<th>Medication</th>
<th>Dose</th>
<th>Route</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metoclopramide (oral)</td>
<td>10 mg</td>
<td>PO</td>
<td>q4h</td>
</tr>
<tr>
<td>Omeprazole (oral)</td>
<td>20 mg</td>
<td>PO</td>
<td>q8h</td>
</tr>
<tr>
<td>Metronidazole (oral)</td>
<td>500 mg</td>
<td>PO</td>
<td>q8h</td>
</tr>
<tr>
<td>Ciprofloxacin (oral)</td>
<td>250 mg</td>
<td>PO</td>
<td>bid</td>
</tr>
<tr>
<td>Amoxicillin (oral)</td>
<td>500 mg</td>
<td>PO</td>
<td>q12h</td>
</tr>
<tr>
<td>Metronidazole (oral)</td>
<td>500 mg</td>
<td>PO</td>
<td>q8h</td>
</tr>
<tr>
<td>Ciprofloxacin (oral)</td>
<td>250 mg</td>
<td>PO</td>
<td>q12h</td>
</tr>
<tr>
<td>Amoxicillin (oral)</td>
<td>500 mg</td>
<td>PO</td>
<td>q8h</td>
</tr>
</tbody>
</table>

Notice that all of these medications are preceded by “Hx” (for Historical) or “Rx” (for Prescriptions).
Medication View

In this view the inpatient and outpatient medications are intermingled so they can be compared.

Each line may contain more than one entry. Users may need to click on the “+” symbol to show underlying meds. Cozaar and Doxorubicin lines have been expanded here. Historical home meds are marked with “Hx” and prescription home meds are marked with “Rx.”

Medications without a leading “Hx” or “Rx” are inpatient medications.

Users can print a list of medications and change viewing preferences for this tab by selecting Medication Profile then “Preferences” from the dropdown.

Preference settings include resetting column widths and choices for generic/brand name display.
Several actions can be performed from the Medication Orders dropdown menu. Users must first select one of the medications by clicking on the medication name. In this example Cozaar has been selected.

**Convert to Prescription and Print Rx** is not available

**Print English Leaflet** and **Print Spanish Leaflet** will print a patient information leaflet on the nearest printer. This leaflet will not have the patient’s name printed on it.

**Reference Text**

Will open the Drug Reference Tab and display information for this medication.

Reference Text comes from Cerner’s Multum database.

Users can also select the “Education Leaflet” tab in this window to see a patient information leaflet.

Right click anywhere on the leaflet information window to print the Drug Reference or the Patient Education Leaflet with the patient’s name at the top of the page.
Micromedix drug information is available.

To access Micromedix, in PowerChart Organizer (from the Inbox or Patient List tabs) click on the Launch Application icon then “Micromedix”.
CHAPTER 7

Introduction to Notes/Documents

Chapter 7 Highlights

- How to locate a document
- How to view an image
- How to view an Addendum
- Overview of Patient Info tab
- Overview of Pediatric Growth Chart
The Notes/Documents Tab

The Notes/Documents Tab allows users to view documents originating from transcription, or scanned images. Physicians will use this tab to view dictated reports such as History & Physical Examinations (H&Ps), Operative reports, or Consult notes. Outside Reference Laboratory results will make their way here in the form of scanned images. Electronic nursing notes will also appear here. After discharge, paper documentation, such as hand-written orders and progress notes, will be scanned into the system and appear within the appropriate folder under this tab.

The default Clinical Range for the Notes/Documents Tab is 7 days in the past.

The Notes/Documents Tab is organized with a Navigator window (located on the left side), Clinical Range Bar, and a Document window. The Clinical Range defaults to 7 days in the past.
The **Navigator Window** helps to organize Notes and Documents and allows users to easily move between different types of documents using one of several techniques.

Documents are stored within a folder tree, similar to Windows Explorer favorites. With a single click, users can rearrange the tree and make it easier to find documents. When first opened, documents will be sorted by type. History and Physical documents will automatically open once this tab is selected.

The large arrows at the bottom of the Navigator allow users to open the next document in the tree without the need to open a folder and double-click on a document.
Documents will appear in the Navigator according to a document folder hierarchy. A copy of this hierarchy is shown here.

The Progress Note and Physician Orders folders will contain only images of paper progress notes and order sheets scanned into the system after discharge.

In many cases the document title or description may not fit within the Navigator. The width of the Navigator window can be changed. Drag the vertical gray bar between the Navigator and Document Window to the left or right, as desired.

This will allow users to see more of the document description to help locate a document.
The **Navigator window** can be hidden from view to maximize the document view. To hide the Navigator Window and maximize the Document Window, select **Documents > Maximize View** from the drop down menus at the top of the screen.

To restore the Navigator Window, select **Documents > Normalize View** from the drop down menus at the top of the screen.

The **Document Window** will always contain at least 2 window *panes*. The main **Document pane** is a view of the document itself. It contains text generated by information inputted into the computer system or transcribed documents rendered in textual form.

The **Revision History Pane** contains the revision history of the document.

The revision history pane is hidden from view at the bottom of the screen by default. To enlarge the revision history window, hover over the gray bar at the bottom of the document window and drag its border upward.
The revision history pane displays details of actions taken on the document.

To see an abbreviated version of the document’s revision history, users must first select a document in the Navigation Window and then select **Documents > View History** from the drop down menus at the top of the screen.

The file drawer icon at the top right of this screen is a shortcut for this menu command (not shown here).

The abbreviated version of a document’s history will only reveal the status and valid dates of the document. To see more complete information about the document’s revisions, users must enlarge the Revision History Pane at the bottom of the Document window.
The Document Window will contain an *Image pane* if the document has an attached scanned image of a paper document. The *image pane* will appear at the top of the Document window with a small toolbar below it. The toolbar allows users to enlarge, reduce, rotate, or manipulate the scanned image in several ways.

When an image pane is displayed, the middle window (the *Document pane*) contains basic document information, such as the document type, document title and the date. Any document with an attached image will contain the statement “This document has an image” at the bottom.


To see an image that is not automatically displayed, users can click on the icon at the top of the page or select

**View > View Images from the Menu Bar**

A pop-up window will open to display the image.
In the case of Radiology images, a pop-up Internet Explorer window will automatically open, log into the PACS system, and show the Radiology image.

In the case of scanned images that have not automatically appeared in an image pane, the image will appear in a pop-up window or a new image pane will appear to show the image.

Consent and legal forms are scanned in the HIM department after discharge. These scanned images may appear in the main Document pane, along with textual data about the type of document.

These scanned documents may not appear with a toolbar for manipulating the image. Users can add the toolbar by right clicking anywhere within the Document Pane and selecting “Show Toolbar.”

The toolbar is shown in this screen shot.

Right click and select “Hide Toolbar” to remove the toolbar.
Sometimes a document will be modified after its original creation. In this case the Document window text will contain a prominent red notice:

**Document Contains Addenda**

Addenda are usually inserted at the end of a document. Scroll to the bottom of the document to see the modification.

It is not possible currently for clinicians to modify documents. At this time there are two methods to correct errors:

1) Any document may be modified by printing a copy of the document, writing corrections directly on the printed copy, and then send/fax to HIM.

2) Transcribed documents, such as consult notes, can be corrected by dictating a correction into any Dictaphone.
Within i-Extend an erroneous document is marked with an electronic “in error” flag along with a reason for the erroneous charting. A prominent red *In Error Report* will appear at the top of the document. Users can hide these erroneous documents by selecting **Documents > Filter In Error Documents** from the drop down menu.

The document will then disappear from the Document tab, but they will always be preserved as a permanent part of the patient’s electronic chart.

Users can change viewing preferences for the Notes/Documents Tab by selecting **Documents > Options** from the drop down menu.
The first tab of the Options pop up window allows users to specify Document Types for Ad Hoc charting. This is a nursing function and will not be used by physicians. Changes made here will not affect the physician view.

Select the Index Defaults tab on this window to change physician user defaults.
If checked, the Documents for selected encounter checkbox will limit displayed documents to the current encounter only. We have left this unchecked so that physicians can look at all documents from all encounters.

The Filtered By date range is defaulted to show records for the last 7 days. This may be changed to another setting more appropriate for the user’s needs.

View Preferences are set for a Chronological display with the Modification History pane closed so document viewing is maximized.

The Notes/Documents Tab is defaulted to automatically expand and open the first H&P document.
The Patient Info Tab

The Patient Info tab contains basic information about patient allergies, demographics, encounters, physician relationships and vaccinations administered within the FH system. There is also an Advanced Growth Chart intended for pediatricians.

The Patient Info Tab first opens to a list of patient Allergies. This allergy information is obtained at intake interviews during current and prior encounters.

Patient allergy information can also be viewed from a Patient List (right click on a patient name & select “Patient Snapshot”) or the Orders Tab (under the Allergies Clinical Category section).

With the display drop-down box, users can filter the list to include All Reactions, as shown here (includes all current and past entries), All Current Allergies (includes only current true allergic reactions), or All Current Reactions (includes both current true allergies as well as other types of reactions such as nausea).

Drug Allergy entries will be check-marked whereas non-drug allergy entries, such as Food Reactions, will not be check-marked.
The “Perform Reverse Allergy Check” button compares the current allergy list with Medication orders. If any matches are found, clinicians will see this screen and will be given an opportunity to override the conflict.

A forward allergy check (comparing a medication to the allergy list) is automatically performed each time a medication is ordered.

Since forward allergy checks are automatically performed when medications are ordered, reverse allergy checking is used only when a patient’s allergy profile is modified.

Allergies and Reactions can be added, updated or cancelled from the Allergy drop down menu or by right clicking anywhere on the allergy profile list. Modifications to the Allergy profiles will only be performed by Nursing staff.

Physicians can change allergy display preferences, such as which columns to display in the allergy profile, from this drop-down menu, if desired.
The **Visit List** tab contains a list of all visits (encounters) with the hospital as of May, 2007. These visits could include inpatient admissions, outpatient procedures, or other visit types. Each visit is assigned a different FIN (FIN=Financial Identification Number, also known as an “Account Number”).

Users can select one of these visits to see the type of encounter, which physicians saw the patient during that encounter, what health plan was used at that time, and a list of the diagnoses associated with the encounter.

Double clicking on a visit will open the patient’s chart to that particular encounter to view clinical data.

The **Patient Demographics** tab contains basic patient information, including marital status, religion, language, next of kin relationships and contact numbers.
i-Extend has facesheet information across several views. To print a facesheet, go to the “Task” drop down menu and select “Reports”.

On the Reports menu, select “Facesheet” and press the “Print” button. A facesheet will print on the Nursing unit printer. You can select a different hospital network printer if you know the printer’s identification name.

To print reports when outside the hospital, you must use the i-Extend Explorer feature. From the Organizer (Inbox) page, click on the Explorer icon and select the desired report. It will print on any printer connected to your home or office computer.
The **PPR Summary** tab will display all Patient Provider Relationships (PPR) for the patient’s current visit. Florida Hospital uses only Visit Relationships, not “Lifetime” Relationships.

The Visit Relationship list defaults to all Active Relationships only, but users can uncheck this checkbox to see all Active and Inactive Providers that have been involved with the patient. The list can also be restricted to include only the user’s Active Relationships with the patient.

All users, including nurses, care techs, case managers, and others, must declare a relationship when they first open a patient’s chart.

Users can sort the list by Name, Relationship, Status or Date. Simply click on any column header.

Users can inactivate relationships here, but only for themselves. Users can also inactivate a relationship from the Patient List tab by right clicking on any patient’s name.
The **FH Received Vaccines** tab contains information about vaccinations administered at Florida Hospital. This tab will *only* contain information about vaccinations administered while a patient was under Florida Hospital’s care.

The **Advanced Growth Chart** tab is similar to the FH Received Vaccinations tab.
CHAPTER 8

Introduction to INet

Chapter 8 Highlights

- Overview of INet
- How to use the Advance Graph
The INet Tab

Early implementations of EMR software required nurses to document care on special electronic forms. Results and Medication administrations were viewed in a different area, forcing nurses to frequently move between two or three tabs. This slowed workflow and made it difficult to see trends. Cerner created INet, (Interactive View) to combine the data viewing and input functions under one tab, allowing nurses to spend more time with patients. Medication administration is still documented on the MAR, but the ability to correlate treatments (such as insulin) with outcomes (like a glucose level) in one place makes it easier to see trends and improve care. Although INet was created for nurses, it is available for the physicians to view.

INet includes several applications including Advanced Graphing, ICU Flowsheet, and the IV titratable drips. These applications interface with BioMedical Devices attached to patients. The data feeds from these devices can be transferred, or charted to the patient's medical record when the Critical Care nurse or other caregiver selects data and sends it to the ICU Flowsheet. Caregivers can also chart directly onto the ICU Flowsheet, where results are also displayed. Data posted to the ICU Flowsheet is instantly available as a result on other views, such as on the Results Tab.

The Advanced Graphing tab allows users to see graphical representations of intake and output measurements, bedside medical device measurements, and standard numeric values such as laboratory results, assessments, and medication doses.
The INet tab is organized with a Navigator Window, Clinical Range Bar, and either one or two Data Windows. There is also a Filter Section above the top data window.
The Navigator window consists of multiple Bands, each of which contains multiple Sections. Examples of Bands are Med/Surg IV Lines, Incisions/Wounds, etc. Sections within the Medical Surgical Band include Adult Vital Sgins, Alarms, etc.

Each Band was created by Nursing to facilitate result viewing and documentation for a group of nursing functions. Different Bands are grouped together for a particular view based on the location of the patient.

There is a view (group of Bands) for a patient in Adult Critical Care. There is a different view (group of Bands) for a patient in a Medical Surgical Unit.

The Medical Surgical Band automatically opens when users first click on this tab, because this is the most common type of nursing unit and group of nursing functions.
Each Band contains multiple Sections.

Nurses and physicians set up the sections based on documentation needs and methods for a particular nursing unit.

If there is a check mark in front of a section and/or the section name is **Bolded**, the section contains results for the dates selected that can be displayed within the data window.
The data within a section is not automatically displayed in the data window. Double click on a section in the Navigator window to display that section’s results in the data window.

If the Section is highlighted in yellow, it is currently being displayed at the top of the data window.

If a section is highlighted in blue, it is selected for display in the data window, but may not be visible if that section’s data is above or below the section in the window. For example, in this screen shot the Pain Eval section is at the top of the data window. The Adult Vital Signs Section is being displayed, but is above the Pain Eval within the data window. The ADL Elimination section is also being displayed, but is below the bottom of the window.

To view a section that is above or below the section currently displayed, either click on that section in the Navigator window or use the vertical scroll bar on the right side of the window.
Only the INet tab allows users to see Nursing documentation, results and administered medication doses on the same screen.

The INet tab can have either one or two Data windows open at a time. Physicians will see two data windows when the tab is first opened.

Users can close or re-open the split window by clicking on the split view icon on the INet toolbar.

Each Data window can display results from one of the Bands at a time. It is not possible to display results from a single band in both the top and bottom data windows at the same time.

In this screen shot the Medical Surgical Band is open in the top data window and the Advanced Graphing Band is displayed in the bottom window.

To display band results within one of the data windows, users must:

1) Select one of the two data windows (click anywhere inside the window). If no data window is selected, the top one will be used by default.
2) Click on the Band to display.
3) Click on one or more of that band’s Sections to display.

It’s easy to see which sections contain results, because they will have a checkmark and/or will be **bolded**.

To open a different band for viewing in the other window, users must follow the same sequence. **Remember to first click inside the desired data window, or data will be displayed in the most recently used data window.**
Once results from a section are displayed inside the data window, users can hide information to free up more display space within the window for your view.

To remove results from a display window, right click on the section heading within the data window.

**Collapse** will collapse the section, but leave the collapsed section within the window.

**Close** will remove the entire section from the window.

Display windows can be resized by dragging their edges up or down. The Navigation window can be resized by dragging its right edge to the left or right.

The Navigation window can be completely removed by selecting **View > Collapse Navigator** from the top menu bar. This is not recommended, however, as it makes navigation difficult.
Within either of the data windows empty rows can be hidden. Select Options from the menu and uncheck “Show Empty Columns/Rows”

This will reduce empty white space and maximize the amount of results viewable at one time. If new results become available on one of the hidden rows, the hidden row will reappear automatically.

Items to mention about the INet tab:

- All bands (except Advanced Graphing) display data in reverse chronological order, with newest data on the left side.
- The Advanced Graphing band always displays data in chronological order, with the newest data on the right side. This preference cannot be changed and is necessary so graphs will flow conventionally from left to right.
- Users should pay attention to the time scales, as result times may flow in opposite directions between the top and bottom windows. Furthermore, one window may show data at hourly intervals, while the other shows data at 8 hour intervals, making correlations between the two windows difficult.
• When the Advanced Graphing Band first opens, it displays data starting 7 days in past and ending at the exact time the graph is opened. If new data is posted at any time after the advanced graph is opened, it will not display. The “As Of” button will not refresh the ending time of the graph.

• The ending time of the advanced graph can be adjusted by right clicking on the Advanced Graphing clinical range. Adjust the ending time one day into the future.

• If users close a patient’s chart and open another, all bands and sections selected to display will be closed. Bands and sections must be re-opened each time users enter a new chart. When moving within one patient’s chart, however, the open bands and sections remain open.
The relationship of a result to its reference range is indicated by its color. Orange = above normal range
Black = within normal range
Blue = below normal range
Red = critical result

These designations will only appear for numerical results. Textual results such as “reduced breath sounds” will not be flagged.

A section containing a critical result will be flagged with an exclamation point (!) in front of the section name in the navigator window.

Clinical Reference ranges are based on the patient’s age and standard or FH defined “normal” ranges.

To view the details of any data point, right click on the result and select “View Details”.

The INet tab has a special Filter Section so all Critical, High, or Low. New, abnormal or flagged results are not being used.

More than one type of filter can be selected at once by using the “And” or “Or” buttons to the right.
The Filter Section has a drop down “Find Item” window that can be used to search for a result type.

Enter the first letter of the desired result (for example “A” for ABGs), then select the specific result (ABG O2 Sat), and all ABG O2 Sat results will be displayed within a separate result window at the top of the data window.

The Filter Section has an optional Seeker to find abnormal results. The Seeker window is hidden by default so result views are maximized.

To reveal the Seeker Window, click on the “Customize View” icon, click on the Preferences tab, and select “Show” for the Seeker.

This is also how users can customize preferences for INet, such as font size or time sequences.
The Seeker functions in the same way as the seeker for the Results Tab. It identifies the relative location of results, and uses colors to show the result’s relationship to reference ranges.

Clicking within the Seeker window will bring nearby results into view in the Data Window.

If a comment is attached to a result, a small triangle will appear in the upper right corner of the result cell.

Users must right click and select “View Comments” to read the comments.
Comments will be visible within the lower portion of the pop-up window. A result can have multiple comments. The most recent comment will always be at the top of the comment window.

Details about the result are also available by selecting the “Result” or “Action List” tabs above the upper window.

Within the data window, some result may display three dots at the end of a result indicating there is additional text. Users can hover over the cell to see the entire result.
The Advanced Graphing Band

The Advanced Graphing Band functions differently than other bands. Time always flows from left to right (and cannot be changed), and the ending time is fixed at the moment the band is opened, as discussed above. Its unique ability to graph both results and medication doses on the same graph make it easy for users to visualize trends.

There are four basic advanced graph folders:

1) Favorites: User created graphs
2) BMDI: Bio-Mechanical Device Input data
3) Intake & Output Totals Graph
4) Standard Graph: These graphs are created by the system to cover special situations.

i-Extend has several standard graphs. These include:

Cardiac Output/Cardiac Index
Hemodynamics
Oxygenation
Oxygenation Status
Vital Signs
It is possible to graph any result that appears as a numerical value within i-Extend, along with medication doses.

If the system does not already contain a suitable standard graph, users can create and save their own personal graphs. Once created and saved, the graph will be available for use by that user on any patient.

To Create a new Favorite Graph, Click on the New Graph icon and enter a name for the graph. In this example we will create a Coumadin Monitor graph.

Select a Graph Template Type.

BMDI Acquired Data Graphs use only data acquired from biomedical devices, such as monitored heart rate and A-line BP.

Standard Graphs can use data from other sources. This selection is more appropriate for a Coumadin Monitoring graph. Highlight the Standard Graph, then press the Next> button.

Users are next asked to enter results and meds to be displayed on the graph.

There are multiple types of Prothrombin Times. For completeness, all of them should be included. This principle may apply to many lab tests.

Similarly, medications may have multiple formulations, so multiple entries may be needed to be sure all doses will appear on the graph. In this case, Coumadin is only listed under the name Warfarin.

We will create a separate Y axis for the INR so the graph is easier to read.

Click Finish and the graph will appear.
To save the graph, click anywhere within the graph window to enable the “Save” icon, then save it.

The “Coumadin Monitor” Graph will not initially appear as a graph option on the Navigator, but will appear on the Navigator within the Favorite Graph folder the next time the user logs in.

Users can display more than one graph at a time. Click on a graph’s name in the Navigation window to display it with other graphs within the Advanced Graphing window.

The *up and down arrows* move a selected graph up or down within the Advanced Graphing window.

Select one of the graphs (click anywhere on the graph) and then click on the *Close Graph* icon to remove a graph from the window.
Customizing INet

To customize INet Bands (other than the Advanced Graphing band), click on the small icon in the upper left corner of the data window.

The **Customize Tab** is used by Nursing. Any changes made here will only affect the display for this particular patient. Physicians should not modify any of the settings on this tab.

The **Preferences tab** controls several aspects of data display. Physicians can modify the settings here as desired.

The **Reset System Defaults** button will change all settings back to the system defaults, which are shown on this screen.

**Encounter filter**: determines whether result data will show across encounters.

**Display Rule**: determines which result to show if more than one is present at that time. Defaults to the last result.

**Normalcy indicators**: uncheck this box to hide the normalcy indicators from view.
Results status: Controls whether checkmarks appear in the Navigator to indicate results are present. This should be left checked.

Clinical range offset: Large time intervals will include more data and slow the screen load time. Recommend only 24 hours.

Font size: Use the “As Of” after changing fonts or the line labels and data may not match.

Time sequence: Reverse chronological is the default.

Column: The default is “actual” time intervals. If modified, the user must exit the patient’s chart and then re-open it before the columns will reset to the new settings.

Note: The Seeker window may not reset to system defaults if it has been customized.